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About the Survivorship Care Plan Builder 
A Survivorship Care Plan is a brief summary, completed by the oncologist, of a patient's 

treatment and direction for future care. Survivorship Care Plans are not intended to replace 

detailed patient charts or chemotherapy flow sheets. Rather they are designed to: 

• Capture information essential to cancer patients’ post-active treatment care 

• Present this information in a manner that is accessible to both patients and their 

primary care physicians 

Survivorship Care Plans have been shown to improve coordination of patient care following 

active treatment. With this short document, the patient, their primary care provider and other 

care providers have the history and guidance they need to adequately monitor the survivor’s 

health moving forward. 

Journey Forward’s Survivorship Care Plan Builder lets you, the oncologist, quickly and easily 

create custom Survivorship Care Plans for your patients and their physicians. This electronic 

software program can be downloaded to your computer’s desktop; it’s private and easy to use. 

SURVIVORSHIP CARE PLAN OVERVIEW 
The Survivorship Care Plan Builder works by creating a unique Survivorship Care Plan for each 

patient, which can then be printed out, emailed or stored electronically. Survivorship Care 

Plans include 5 patient-specific sections as well as several optional appendices that you can 

choose to add or exclude when you print, preview or create a PDF of the plan: 

PATIENT-SPECIFIC SECTIONS 
1. General Information:  

Contact information for the patient and their care team. 

2. Background Information:  

Key facts about the patient’s diagnosis and medical background. 

3. Treatment Plan:  

Key information about the planned course of cancer treatment. 

4. Treatment Summary:  

Summary information about the patient’s actual treatment. 

5. Follow-up care:  

Suggested schedule for follow-up tests and care.  

OPTIONAL APPENDICES 
1. ASCO Surveillance Guidelines 

2. Symptoms to watch for 

3. Potential late effects of treatment 

4. Resources for physicians 

5. Resources for patients 
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Downloading and Installing 
This section describes how to download and install the Survivorship Care Plan Builder. 

Before you begin, check your computer setup to make sure that you can install and run the 

application successfully. It’s also a good idea to close any open applications, such as Microsoft 

Outlook® or Microsoft Word®.  

SYSTEM REQUIREMENTS 

Operating System:  

 

The Survivorship Care Plan Builder runs on Microsoft Windows XP, 

Windows 2000 and Windows Vista. Please make sure that you have 

the latest Windows service pack installed for your operating system.   

NET Framework:  The Survivorship Care Plan Builder uses Microsoft’s .NET 

Framework, Version 2.0. Most versions of Windows XP and all 

versions of Windows Vista will already have .NET installed. If you do 

not have .NET, you can find it on www.microsoft.com/downloads. 

Storage 

Requirements:  

The Survivorship Care Plan Builder requires 10MB of free disk space 

if the .NET Framework is already installed, and 290MB if it is not.  

RAM Requirements: The Survivorship Care Plan Builder requires a minimum of 447 MB 

of RAM for installation. 

Screen Resolution: The Survivorship Care Plan Builder requires a minimum screen 

resolution of 1024 x 768 pixels. 

 

DOWNLOADING THE SURVIVORSHIP CARE PLAN BUILDER 
You can download the Survivorship Care Plan Builder from www.JourneyForward.org. Be sure 

to note where you choose to save the installer. We recommend a location that's easy to find, 

such as your Desktop. 

INSTALLING THE SURVIVORSHIP CARE PLAN BUILDER 
When you’ve finished downloading the Survivorship Care Plan Builder, you’ll see a file named 

SCPBSetup.exe. Double-click this file to begin the installation. Then follow the prompts. You’ll 

need to agree to the End User License Agreement (EULA) to complete the installation. You can 

view a complete copy of the EULA at: www.JourneyForward.org/EULA. 

Tip: On Windows Vista, you can check your operating system, service pack, and available 

memory by selecting  

     Control Panel > System & Maintenance > System  

On earlier Windows systems, select  

     My Computer > Properties and then the General tab 

http://www.microsoft.com/downloads/details.aspx?familyid=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en�
http://www.journeyforward.org/EULA�
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When the installation is complete, you’ll see the icon on the left on your computer’s 

desktop. You can launch the Survivorship Care Plan Builder by double-clicking this icon 

or by going to the Start Menu and choosing the Survivorship Care Plan Builder 

application from the Survivorship Care Plan Builder folder. 
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Getting Started 

FINDING YOUR WAY AROUND THE SURVIVORSHIP CARE PLAN BUILDER 
When the Survivorship Care Plan Builder launches, it displays the Start Dialog. From the Start 

Dialog you can open and continue work on an existing Survivorship Care Plan (using areas 1 

or 2 in the image below) or start a new Survivorship Care Plan by selecting the type of cancer 

the patient is being treated for (area 3 in the image below). 1

Figure 1. Survivorship Care Plan Builder Start Screen 

You can also use the following keyboard shortcuts: 

 

Shortcut Action 

Alt+O Open the selected Survivorship Care Plan 

Alt+R Open the Browse dialog. 

Alt+B Create a new Survivorship Care Plan for a breast cancer patient. 

Alt+C Create a new Survivorship Care Plan for a colon cancer patient. 

Once you’ve opened a new or existing Survivorship Care Plan, the Main Window of the 

Survivorship Care Plan Builder is displayed. The Main Window is made up of three primary 

areas: the Sidebar, the Menu Bar, and the Care Plan Form. 

                                                

1 Today the Survivorship Care Plan Builder can only create care plans for breast and colon cancer patients. 
In the future it will support other cancer types as well. 
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Figure 2. Survivorship Care Plan Builder Main Window 

SIDEBAR 
The Sidebar has two sections: The Care Plan Sidebar and the Tools Sidebar. The Care 

Plans Sidebar provides shortcuts for creating new Survivorship Care Plans, and 

opening, printing, and saving existing Survivorship Care Plans. The Tools Sidebar 

provides access to the regimen library, preferences, the User Guide, and NearSpace 

technical support. The sidebar functions (and their keyboard equivalents) are: 

Care Plans Sidebar 

• New (Ctrl+N): Create a new Survivorship Care Plan for breast or colon cancer. 

• Open (Ctrl+O): Open an existing Survivorship Care Plan. 

• Save (Ctrl+S): Save the Survivorship Care Plan which is currently open. 

• Print (Ctrl+P): Send the open Survivorship Care Plan to the printer, preview 

it, or create a PDF. 

Tools Sidebar 

• Regimens (Ctrl+E): Add, remove, or customize regimens. 

• Preferences (Ctrl+F): Change the units in which weight and height are 

measured, upload your practice logo for inclusion in the printed or PDF 

Survivorship Care Plans, or change the default location where Survivorship 

Care Plans are stored. 

• User Guide (F1): Launch this guide. 

• Contact Us: Send an email to NearSpace, Inc., the developers of the 

Survivorship Care Plan Builder. 



 

 

© NearSpace, Inc. 2008  6 of 34 

MENU BAR 
The menu bar along the top of the Main Window provides all of the functionality found 

in the sidebars and more. The menu items are: 

File Menu 

• New (Ctrl+N): Create a new Survivorship Care Plan (for breast or colon 

cancer). 

• Open (Ctrl+O): Open an existing Survivorship Care Plan. 

• Save (Ctrl+S): Save the current Survivorship Care Plan. 

• Save As: Save the current Survivorship Care Plan under a different file name 

or in a different location. (This will create a copy of the original Survivorship 

Care Plan.) 

• Print (Ctrl+P): Send the open Survivorship Care Plan to the printer, preview 

it, or create a PDF document of it. 

• Recent Care Plans: Open one of the last four Survivorship Care Plans 

viewed. 

• Exit: Close the Survivorship Care Plan Builder. 

Edit Menu 

• Cut (Ctrl+X): Put selected text on the clipboard and delete it from the 

Survivorship Care Plan. 

• Copy (Ctrl+C): Put selected text on the clipboard. 

• Paste (Ctrl+V): Put the text in the clipboard into the Survivorship Care Plan at 

the current cursor position. 

• Next Section(Alt+Right Arrow): Display the next section of the Survivorship 

Care Plan form. 

• Previous Section(Alt+Left Arrow): Display the previous section of the 

Survivorship Care Plan form. 

Tools Menu 

• Regimens (Ctrl+E): Add, remove or customize regimens here. 

• Preferences (Ctrl+F): Change the units in which weight and height are 

measured, upload your practice logo for inclusion in the printed or PDF 

Survivorship Care Plans, or change the default location where Survivorship 

Care Plans are stored. 

Help Menu 

• User Guide (F1): Open this guide. 

• Contact Us: Send an email to NearSpace, Inc., the developers of the 

Survivorship Care Plan Builder. 

• Check for Updates: Check to see if you are running the latest version of the 

Survivorship Care Plan Builder. 
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• Configure updates: Change the schedule and settings for checking for 

updates. 

• About: Check which version of the Survivorship Care Plan Builder you are 

running. 

CARE PLAN FORM 
The Care Plan Form is the area in the Survivorship Care Plan Builder where you enter 

patient information. It consists of five short screens that capture the patient’s 

diagnosis, treatment and follow-up care. There are no required fields, but the more 

information you provide the more thorough the Survivorship Care Plan will be. 

These are the types of fields you will encounter in the Care Plan Form: 

• Text Fields: Text fields allow you to enter information as free-form text.  

• Date Fields: Date fields automatically fill in a date as soon as you click into them. The 

default is usually either the current date or the date last entered. The patient age field, 

however, will calculate a year based on the age of the patient at diagnosis. Depending 

on the version of your system, a calendar icon or down arrow will appear at the end of 

date fields. Click this image to display a calendar from which you can select a date. 

You can also edit dates with the keyboard or remove them with the delete key. 

• Selection Fields: Selection fields have a small down arrow at the right end of the 

field. These fields allow you to select ONE item from a list. In some cases you can 

enter your own text in these fields instead of making a selection. 

• Multi-Selection Fields: Multi-selection fields allow you to choose multiple items 

from a list. To select an item, check the box next to it. When you have finished 

selecting items, click the Done link to close the dialog. 

• Dependent Fields: Dependent fields are those fields which are not visible until 

the program determines you need them. For example, the date field for surgery 

does not appear until you have entered the surgery type, thus indicating there was 

a surgery. These dependent fields will appear automatically when they are needed. 

To move to a different field, just click the mouse on the field you want to select. 

Alternatively you can press the Tab key to go to the next field, and Shift-Tab to go to 

the previous field. 

MOVING BETWEEN SCREENS 
There are several ways to move between screens in the Care Plan Form: 

• Use the section links at the top of the Care Plan Form to move between sections. 

• Use the Previous Section and Next Section links at the bottom of the Care Plan 

Form to move ahead or back one screen at a time.  

• Use the Next Section and Previous Section items in the Edit Menu at the top to 

move forward or back a screen. 

• Use keyboard short cuts Alt+Right Arrow to move forward one screen, and 

Alt+Left Arrow to move back one screen. 
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• If the cursor is in the last data field on a screen, the Tab key will take you to the 

first field of the next screen. If the cursor is in the first data field of a screen, 

Shift-Tab will move to the first data field on the previous screen. 

RESIZING THE MAIN WINDOW 
The Main Window of the Survivorship Care Plan Builder can be resized by selecting the top or 

bottom border or any corner of the window and dragging it to a different length. Or click on 

the box in the upper right corner of the window to maximize the program screen. Only the 

length of the window can be changed, not the width. 

If the screen is too short to display the full content of the form, a scroll bar will appear on the 

right side of the window which will allow you to access all of the form content. 
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Working with Survivorship Care Plans 

CREATING A NEW SURVIVORSHIP CARE PLAN 
The first thing you see when you open the Survivorship Care Plan Builder is the Start Screen. 

Select the breast cancer or colon cancer button at the bottom of the screen to start a new 

Survivorship Care Plan (see Figure 1 on page 4). If the Survivorship Care Plan Form is already 

open, you can also create a new Survivorship Care Plan by selecting New from the Sidebar or 

File Menu (see Figure 2 on page 5). 

OPENING AN EXISTING SURVIVORSHIP CARE PLAN 
On the Start Screen, under the Open an existing Survivorship Care Plan header, you will see a 

list of recently viewed Survivorship Care Plans. To open one, click on the plan name and then 

select the Open button (or just double-click on the plan name). If your plan is not listed, use 

the Browse button to locate the plan you want to view or edit. By default, Survivorship Care 

Plans are saved in a folder named “Survivorship Care Plans” under your My Documents folder. 

If the Care Plan Form is displayed, you can open an existing Survivorship Care Plan by 

selecting Open from the Sidebar or File Menu (see Figure 2 on page 5). 

EDITING SURVIVORSHIP CARE PLANS 
Whether you create a new plan or open an existing plan, once the Care Plan Form is displayed 

you will be able to edit any field. There are no required fields, but the more information you 

provide the more thorough the Survivorship Care Plan will be. There are 5 sections in the Care 

Plan Form: 

SCREEN 1 OF THE CARE PLAN FORM: GENERAL INFORMATION 
Enter general information about the patient and contact information for key members 

of the patient’s care team.  

SCREEN 2 OF THE CARE PLAN FORM: BACKGROUND INFORMATION 
Provide information on the patient’s medical background and diagnosis, including 

information about any surgery preceding chemotherapy, family history of cancer, 

genetic testing, and major comorbid conditions. Note that some fields on this screen 

only become visible when needed. For example, in the breast cancer form, the Date 

field for “Axillary Dissection” only appears after you’ve indicated that an axillary 

dissection has taken place. 

SCREEN 3 OF THE CARE PLAN FORM: TREATMENT PLAN  
Enter information describing the planned course of treatment. Values for BSA and BMI 

will be automatically calculated and displayed once the patient height and weight are 

entered. When you select a regimen a summary of the dosage and schedule displays. 
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SCREEN 4 OF THE CARE PLAN FORM: TREATMENT SUMMARY  
Enter information describing the actual course of treatment for this patient. This 

includes information about any chemotherapy dose reductions, the number of cycles in 

which each agent was administered, serious toxicities, hospitalizations during 

treatment, additional surgeries, and/or medications.  

SCREEN 5 OF THE CARE PLAN FORM: FOLLOW-UP CARE 
Enter the schedule for follow-up care testing and any preventive care 

recommendations. 

 

 

 

SAVING CHANGES TO A SURVIVORSHIP CARE PLAN 
You can save the Survivorship Care Plan you are working on by clicking Save in the left 

sidebar, or from the File menu. You can also use Ctrl+S on your keyboard. The default name 

for the Survivorship Care Plan is the patient name or identifier. 

DELETING A SURVIVORSHIP CARE PLAN 
You can delete Survivorship Care Plans in the same way you delete any file or document. Use 

Windows Explorer to navigate to the directory in which a plan is saved. Right click on the 

correct file and select the Delete button. You can also access Windows Explorer from the 

Survivorship Care Plan Builder by clicking the Open button in the left sidebar. 

PRINTING, EMAILING AND STORING SURVIVORSHIP CARE PLANS 
You can print a Survivorship Care Plan from the Main Window of the application by clicking the 

Print button in the left sidebar, selecting Print from the File menu, or typing Ctrl+P. The 

following dialog will display:  

Figure 3. The Print Options Dialog 

Tip: You can leave any field in any of the five sections blank. Each section also has a space 

for adding personal notes. 
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From the Print Dialog you can choose to append any of several optional sections to the current 

Survivorship Care Plan, including: 

• ASCO Surveillance Guidelines 

• Symptoms to watch for 

• Potential late effects of treatment 

• Resources for physicians 

• Resources for patients 

The content for these optional sections of your Survivorship Care Plans can be found in 

Appendix A: Care Plan Appendices. 

By default, all the appendices are checked. You can uncheck all items by selecting the Uncheck 

all button, or add or remove individual items by checking or clearing the checkbox next to that 

item. Your selections will be remembered the next time you print a Survivorship Care Plan. 

Once you have selected the items to include in the Survivorship Care Plan, use the buttons at 

the bottom of the Print Options Dialog to: 

• Print: Send the Survivorship Care Plan to the printer of your choice. 

• Preview: Display a preview of this patient’s full Survivorship Care Plan on your 

desktop. (From the preview you can then choose to print or close the window and not 

print). 

• PDF: Create a PDF file that can then be emailed, stored, viewed, or printed. 

• Cancel: Cancel the print operation. 

SHARING SURVIVORSHIP CARE PLANS ELECTRONICALLY 
To share a Survivorship Care Plan electronically simply: 

1. Open the Survivorship Care Plan in the Survivorship Care Plan Builder 

2. Select print. 

3. Check the appendices you wish to include with this Survivorship Care Plan. 

4. Select the PDF button at the bottom of the Print Options dialog. You will be prompted 

to name the Survivorship Care Plan. Be sure to note where you save it, then click 

Save. (By default it will be saved in the Survivorship Care Plan directory in My 

Documents.) 

5. The Survivorship Care Plan has now been saved as a PDF file.  

You can now send the PDF file electronically via email as an attachment, or move the file to 

another location such as a central server where it can be accessed by other care providers.  

Tip: Recipients do not need the Survivorship Care Plan Builder to view the PDF 

Survivorship Care Plans electronically. All PDF Survivorship Care Plans can be viewed using 

Adobe’s free Acrobat Reader that can be downloaded from http://www.adobe.com. 

http://www.adobe.com/go/EN_US-H-GET-READER�
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Managing the Regimen Library 
The Survivorship Care Plan Builder includes a number of common breast and colon cancer 

regimens. These are available for selection in the Treatment Plan section of the Care Plan Form. 

The Regimen Setup function allows you to add, customize, and delete regimens from the regimen 

selection lists in the Care Plan Forms. (For more information on Care Plan Forms see page 7.) 

You can get to the Regimen Setup Dialog at any time by selecting Regimens from the Tools 

Sidebar or Regimen Setup from the Tools menu. 

Figure 4. The Regimen Setup Dialog 

The Regimen Setup dialog displays all of the regimens that are included in the Survivorship 

Care Plan Builder’s Regimen Library. This includes Predefined Regimens, the commonly used 

regimens already included in the Survivorship Care Plan Builder, as well as Custom Regimens 

that you or another user may have added to the Regimen Library. 

Items with a check mark are available in the Care Plan Form, while items without a check 

mark are not. Items with a red asterisk have been added to the Regimen Library by a user. 
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ADDING OR REMOVING REGIMENS FROM THE REGIMEN LIST 
The “Regimen List” is a subset of the regimens in the Regimen Library. The Regimen List is the 

list of regimens that are available for selection on the “Treatment Plan” screen of the 

Survivorship Care Form. You can remove a regimen from the Regimen List, making it 

unavailable to the Survivorship Care Plans, by clearing the checkbox to the left of its name. To 

include a regimen, click the same box to add a checkmark. To remove all regimens for a 

particular cancer type, clear the check box that appears to the left of the cancer type.  

Removing regimens from the Regimen List will not remove them from the Regimen Library.  

CREATING NEW REGIMENS 
If your practice uses a regimen that is not included in the Survivorship Care Plan Builder’s 

Regimen Library, you can add it in one of two ways. You can create a copy of an existing 

regimen and customize it, or you can build a new regimen from scratch. 

CUSTOMIZING AN EXISTING REGIMEN 
To make a customized copy of an existing regimen, select (highlight) the name of the 

regimen from the Regimen Setup Dialog, then click the Customize regimen button. 

Please Note: If you choose to customize a Predefined Regimen a message will appear 

informing you that you cannot alter predefined regimens. You may however create a 

new regimen based on the chosen predefined regimen. Select Yes to continue.  

The Regimen Editor screen will appear with the information from the regimen you are 

using as a starting point already filled in. Note that the name of the regimen is now 

preceded by the word “Custom.” You can (and probably should) edit this name; 

however, you can’t give the regimen the same name as a regimen that is already in 

the Library. 
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Figure 5. The Regimen Editor Dialog—Customizing an existing regimen 

Modify your copy of the regimen as needed. For example, use the drop-down list to 

select the appropriate cancer type. In the Summary field, edit the information on 

dosing, schedule and route. Then click into the chemotherapy table to add, edit or 

remove chemotherapy agents. You can also add citation information to your Custom 

Regimen. 

Save your changes at any time by clicking the Apply button or click OK, if you have no 

further changes to make. Once the new regimen has been saved, it will appear in the 

Regimen Library. On the Regimen Setup Dialog custom regimens are identified with a 

red asterisk to help you distinguish them from the Predefined Regimens included with 

the Survivorship Care Plan Builder. 

CREATING A NEW REGIMEN FROM SCRATCH 
If you prefer to create your own regimen from scratch you can do so. The process is 

nearly the same as customizing an existing regimen; the difference is that you will 

have no starting values to work from.  

Begin by selecting the Add a new regimen button from the Regimen Setup Dialog.  

When you have completed entering the data for the new regimen, select OK to save 

your changes or Cancel to throw away your changes. 
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Figure 6. The Regimen Editor Dialog—Creating a new regimen 

DELETING REGIMENS FROM THE REGIMEN LIBRARY 
You may only delete new or custom regimens from the Regimen Library. (New and custom 

regimens are identified with a red asterisk.)  

To delete a new or custom regimen from the library select that regimen and then click on the 

Delete regimen button. When asked to confirm the deletion select the Yes button. 

Please Note: You cannot “undo” this operation. Once the regimen has been deleted it is 

permanently removed from the program. The only way to add it back again is to re-create it. 

PREVIEWING A REGIMEN 
To view a summary description of a regimen, select the regimen from the Regimen Library 

and then click the Preview regimen button. A new window will appear with the details of the 

selected regimen.  
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Figure 7. The Regimen Preview Window 

When you have finished reviewing regimen details, click the Close button in the Regimen 

Preview Window. 

 Tip: If you leave the Preview Window open and select another regimen in the Regimen Setup 

Dialog, the newly selected regimen will appear in the Preview Window. You do not have to 

close the Regimen Preview Window to preview another regimen. 
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Setting Preferences 
The Survivorship Care Plan Builder has a several preferences which can be changed by the 

user at any time. They are set in the Preferences Dialog, which can be launched from either 

the Preferences icon on the Tools sidebar, or from the Tools menu. The Preferences Dialog is 

shown below.  

Once you have set the preferences as desired, select the OK button to save your changes and 

close the Preferences Dialog. Alternatively you can also select the Cancel dialog to throw away 

your changes and close the Preferences Dialog, or the Apply button which will save and apply 

your changes but will not close the Preferences Dialog. 

Figure 8. The Preferences Dialog 

CHANGING THE UNIT OF MEASURE 
You can specify whether you want to enter patients’ height and weight in U.S. Standard 

measurements (inches and pounds) or in Metric measurements (centimeters and kilograms). 

Click on the appropriate button to make your choice. The default is U.S. Standard. 

CHANGING WHERE SURVIVORSHIP CARE PLANS ARE STORED 
You can store your Survivorship Care Plans anywhere you like on your computer or on a 

network drive connected to your computer. By default, all Survivorship Care Plans are saved in 

a folder called Survivorship Care Plans, which can be found in My Documents. 

To change the default folder for Survivorship Care Plans, enter the path to your chosen 

directory in the text box or use Windows Explorer to locate an existing directory by clicking the 

Browse button. 
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ADDING YOUR PRACTICE LOGO TO SURVIVORSHIP CARE PLANS 
You can add your practice logo to the printed or PDF version of your Survivorship Care Plans. 

To do so, simply enter the location of your logo image file into the field at the bottom of the 

Preferences Dialog. You can also use Windows Explorer to locate your logo by selecting the 

Browse button.  

Please note: Your logo image should be no larger than 75 pixels tall by 396 pixels wide and 

should be formatted as a JPG, PNG, GIF, or BMP file type. 

The image will display in the Logo preview window, showing you how your logo will fit into the 

available space. The border of the Logo preview window shows the size of the available space. 

If the image is smaller than the available space, the additional space is filled with white. If the 

image is too large it will be clipped to fit into the available space.  

The dimensions of the image you select will appear to the right of the Logo preview window. 

Once selected, your logo will replace the Journey Forward “Cancer Survivorship Care Plan” 

logo in the upper left corner of printed or PDF Survivorship Care Plans. 
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Getting Help and Checking for Updates 

ACCESSING THE USER GUIDE 
To get help using the Survivorship Care Plan Builder, select User Guide on the Tools Sidebar or 

from the Help Menu. 

CHECKING FOR PROGRAM UPDATES 
If your computer is connected to the Internet, you can check for updates to the Survivorship 

Care Plan Builder at any time. Click the Help Menu and select Check for Updates. A dialog will 

appear, letting you know if any updates were found, and prompting you to download and 

install them if applicable. 

Figure 9. Checking for Survivorship Care Plan Builder Updates 

Figure 10. Downloading Survivorship Care Plan Builder Updates 
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CHANGING AUTOMATIC UPDATE SETTINGS 
By default, the Survivorship Care Plan Builder is set up to automatically check for updates every 2 

days. To change this setting, go to the Help Menu and select Configure Update.  

Figure 11. Changing the Automatic Update Settings 
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Appendix A: Optional Survivorship Care Plan Appendices 
You can customize individual Survivorship Care Plans with the following appendices. 

BREAST CANCER-SPECIFIC APPENDICES 

ASCO SURVEILLANCE GUIDELINES (FOR BREAST CANCER) 
Medical history and physical (H&P) examination 

Visit your doctor every three to six months for the first three years after the first 

treatment, every six to 12 months for years four and five, and every year thereafter. 

 

Post-treatment mammography 

Schedule a mammogram one year after your first mammogram that led to diagnosis, 

but no earlier than six months after radiation therapy. Obtain a mammogram every six 

to 12 months thereafter. 

 

Breast self-examination  

Perform a breast self-examination every month. This procedure is not a substitute for 

a mammogram. 

 

Pelvic examination  

Continue to visit a gynecologist regularly. If you use tamoxifen, you have a greater 

risk for developing endometrial cancer (cancer of the lining of the uterus). Women 

taking tamoxifen should report any vaginal bleeding to their doctor. 

 

Coordination of care  

About a year after diagnosis, you may continue to visit your oncologist or transfer your 

care to a primary care doctor. Women receiving hormone therapy should talk with 

their oncologist about how often to schedule follow-up visits for re-evaluation of their 

treatment. 

 
Genetic counseling referral  

Tell your doctor if there is a history of cancer in your family. The following risk factors 

may indicate that breast cancer could run in the family: 

 

• Ashkenazi Jewish heritage 

• Personal or family history of ovarian cancer 

• Any first-degree relative (mother, sister, daughter) diagnosed with breast 

cancer before age 50 

• Two or more first-degree or second-degree relatives (grandparent, aunt, 

uncle) diagnosed with breast cancer 

• Personal or family history of breast cancer in both breasts 

• History of breast cancer in a male relative 
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Not Recommended: The following tests are not recommended for routine breast 

cancer follow-up: breast MRI, FDG-PET scans, complete blood cell counts, automated 

chemistry studies, chest x-rays, bone scans, liver ultrasound, and tumor markers (CA 

15-3, CA 27.29, CEA). Talk with your doctor about reliable testing options. 
 
ASCO® Survivorship Care Plan Surveillance Guidelines. ©2008 American Society of 
Clinical Oncology®. 

SYMPTOMS TO WATCH FOR (FOR BREAST CANCER) 
Patient should report these signs and symptoms if persistent:  

• Abdominal pain 

• Arm swelling 

• Bone pain 

• Chest pain 

• Fractures 

• Hot flashes or other menopausal symptoms 

• New lumps 

• Palpitations 

• Persistent headaches 

• Shortness of breath or difficulty breathing 

• Swelling in legs 

ASCO® Survivorship Care Plan Surveillance Guidelines. ©2008 American Society of 

Clinical Oncology®. 

POTENTIAL LATE-EFFECTS OF CANCER TREATMENT (FOR BREAST CANCER) 
You may experience the following effects after cancer treatment. 

• Surgery:  

Numbness, weakness, pain, loss of range of motion (ROM), or arm swelling 

(lymphedema). 

• Chemo/Biotherapy:  

Fatigue, ovarian failure with associated menopausal symptoms, neuropathy, 

cognitive dysfunction, weight gain, psychological distress, and sexual 

dysfunction; increased risk of leukemia (after anthracycline based therapy), 

osteoporosis from premature ovarian failure, increased risk of cardiac 

dysfunction secondary to anthracycline and/or trastuzumab. 

• Radiation:  

Breast pain, fibrosis,telangectasia, atrophy, poor cosmetic outcome. 

• Hormone therapies:  

Tamoxifen—hot flashes, increased risk of blood clots, uterine cancer, and 

stroke. Aromatase inhibitors—increased risk of osteoporosis and fracture. 

 

Patricia A. Ganz and Erin E. Hahn, J Clin Oncolo 26:759-767. 
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COLON CANCER-SPECIFIC APPENDICES 

ASCO SURVEILLANCE GUIDELINES (FOR COLON CANCER) 
During the first three years following treatment ASCO recommends: 

• Doctor’s visits every 3-6 months  

• Carcinoembryonic antigen (CEA) Test every 3 months (CEA testing is not 

recommended during the administration of adjuvant chemotherapy.) 

• CT Scan of chest and abdomen every year if recommended by doctor 

(Recommended for high-risk patients) 

• Counseling visits every 3 to 6 months 

 

A colonoscopy should be done around the time of surgery. If the examination shows 

no signs of a recurrent tumor or polyps, a colonoscopy should be done at 3 years, and 

if normal, every 5 years thereafter. Acceptable to wait 3 years for follow-up if the pre-

or perioperative colonoscopy examined the entire colon. 

After 5 years, the need for future tests and visits are decided by the patient and 

doctor. 

The following tests are not currently recommended by ASCO for regular follow-up care 

because there is not enough scientific evidence to support a recommendation:  

• A complete blood count (CBC) test or liver function tests 

• A fecal occult blood test, which is a test that looks for blood in the stool 

ASCO® Survivorship Care Plan Surveillance Guidelines © 2008 American Society of 

Clinical Oncologists. 

SYMPTOMS TO WATCH FOR (FOR COLON CANCER) 
Patient should report these signs and symptoms if persistent: 

• Blood in stool 

• Abdominal pain 

• Change in bowel habits 

• Cough that doesn’t go away 

• Bone pain 

• New lumps 

• Nausea lumps 

• Vomiting 

• Loss of appetite 

• Weight loss 

• Fatigue 

Patricia A. Ganz and Erin E. Hahn, J Clin Oncolo 26:759-767. 
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POTENTIAL LATE EFFECTS OF CANCER TREATMENT (FOR COLON CANCER) 
You may experience the following effects after cancer treatment. 

• Surgery:  

Bowel problems, such as diarrhea, fecal leakage/incontinence, constipation, 

bowel obstruction, hernia, pain, colostomy, sexual dysfunction, psychological 

distress 

• Radiation:  

Fatigue, scarring, bowel obstruction, rectal or bladder irritation. 

• Chemo/Biotherapy:  

Fatigue, peripheral neuropathy. 

• Patient should report these signs and symptoms if persistent:  

Diarrhea, constipation, pain with urination, erectile dysfunction, painful 

intercourse, infertility, numbness or tingling in hands or feet. 

 

ASCO® Survivorship Care Plan Surveillance Guidelines © 2008 American Society of 

Clinical Oncologists. 

RESOURCES FOR PHYSICIANS 
Late Effects of Cancer Treatment and Survivorship:  

Strategies for Primary Care and Oncology Care Providers 

A free online Continuing Medical Education (CME) Program available through September 2009, 

providing 3.0 AMA PRA Category 1 Credits. This educational program has been designed to 

promote understanding regarding late effects of cancer treatment and survivorship and their 

role in the long-term surveillance in order to reduce adverse health outcomes of cancer 

Survivors. 

 

http://www.cemedicus.com/cancersurvivorship 

Click “Launch Activity” link to begin the activity. 

 

Cancer Care for the Whole Patient: 

Meeting Psychosocial Health Needs – October 2007 

The report by the Institute of Medicine studies the delivery of psychosocial services to cancer 

patients and their families and identifies ways to improve it. 

 

http://www.IOM.edu 

 

Cancer Survivorship Care Planning – November 2005 

A report by the Institute of Medicine, based on From Cancer Patient to Cancer Survivor: Lost 

in Translation, 2006, details the elements of a survivorship care plan as well as frequent 

questions Survivors may ask. 

 

http://www.IOM.edu 

 

http://www.cemedicus.com/cancersurvivorship�
http://www.iom.edu/�
http://www.iom.edu/�
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From Cancer Patient to Cancer Survivor: 

Lost in Transition Report Recommendations – November 2005 

The recommendations in this report, taken from the Institute of Medicine’s report, From 

Cancer Patient to Cancer Survivor: Lost in Transition, are directed to cancer patients and their 

advocates, health care providers and their leadership, health insurers and plans, employers, 

research sponsors, and the public and their elected representatives. 

 

http://www.IOM.edu 

 

American Society of Clinical Oncology® Chemotherapy Treatment and Summary 

Templates 

Developed by volunteer oncologists, these treatment plan and summary templates for breast 

and colon cancer can be downloaded in a modifiable format allowing oncologists to customize 

and adapt them to suit their own practices. 

 

http://www.ASCO.org 

 

Children’s Oncology Group Long-Term Follow-Up Guidelines for Survivors of 

Childhood, Adolescent and Young Adult Cancers 

These guidelines provide recommendations for screening and management of late effects that 

may potentially arise as a result of therapeutic exposures used during treatment for pediatric 

malignancies. They were developed as a resource for clinicians who provide ongoing 

healthcare to survivors of pediatric malignancies. The screening recommendations in these 

guidelines are appropriate for asymptomatic survivors of childhood, adolescent, or young adult 

cancer presenting for routine exposure-based medical follow-up. 

 

http://www.survivorshipguidelines.org 
 

RESOURCES FOR PATIENTS 
American Cancer Society (ACS) Guidelines on Nutrition and Physical Activity for 

Cancer Prevention 

Updated every five years, this document is a short version of the ACS Nutrition and Physical 

Activity Guidelines. It includes how to maintain a healthy weight and how to stay active. 

 

http://www.Cancer.org 

 

http://www.iom.edu/�
http://www.asco.org/�
http://www.survivorshipguidelines.org/�
http://www.cancer.org/�
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CancerCare 

CancerCare is a national nonprofit group that gives free support services to those affected by 

cancer: people with cancer, caregivers, children, loved ones and those who have lost loved 

ones. These programs include counseling, education, financial and practical help. They are 

given at no cost by trained social workers. Founded in 1944, CancerCare helps more than 

91,000 people each year. And each year, as many as 1.6 million people visit the website to 

learn more and find resources. 

 

Call 1-800-813-HOPE (4673), send an e-mail to info@cancercare.org, or visit the website at 

http://www.cancercare.org. 

 

Cancer.Net™  

Cancer.Net™ is the award-winning patient information website of the American Society of 

Clinical Oncology® (ASCO). ASCO® is the world’s leading professional organization 

representing physicians of all oncology subspecialties who care for people with cancer. This 

website provides timely, oncologist-approved information to help patients and families make 

informed health-care decisions. All content is subject to a formal peer-review process by more 

than 150 medical, surgical, radiation, and pediatric oncologists, oncology nurses, social 

workers, and patient advocates. In addition, ASCO® editorial staff reviews the content for 

easy readability. Cancer.Net™ is reviewed on an annual basis or as needed. 

 

http://www.Cancer.Net 

 

Employee Assistance Program (EAP) 

This service is offered, for the most part, through large employer groups. EAPs help 

employees and their families deal with issues such as: 

 

• Short and long-term disability 

• Personal and emotional concerns 

• Legal and financial advice 

 

EAPs can give access without barriers to an open network of community resources and 

licensed mental health counselors. Employee contact with the EAP is kept private. To learn 

more, ask your employer about your company’s EAP. 

 

Facing Forward: Life After Cancer Treatment 

Written by the National Cancer Institute, this booklet shares the feelings and feedback that 

many people have after cancer treatment. It also offers tips to help people get through this 

time. 

 

http://www.cancer.gov 

 

mailto:info@cancercare.org�
http://www.cancercare.org/�
http://www.cancer.net/�
http://www.cancer.gov/�
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From Cancer Patient to Cancer Survivor: Lost in Transition - video 

This short film by the Institute of Medicine features the stories of cancer survivors and 

supports the need for a Survivorship Care Plan. 

 

http://www.IOM.edu or http://www.youtube.com 

 

Heal: Living Well After Cancer 

Cancer survivors can use the information in this pamphlet for the rest of their lives from the 

day treatment ends. Topics include: 

 

• Cancer’s after-effects 

• Financial security 

• Best nutrition and fitness 

• Working after cancer 

• Faith and belief after cancer 

• Insurance strategies 

 

http://www.healtoday.com 

 

The LIVESTRONG™ Survivorship Center of Excellence 

LIVESTRONG™ Survivorship Center of Excellence is funded by the Lance Armstrong 

Foundation (LAF). These centers: 

• Help people living with cancer deal with the emotional, practical and physical 

issues they will face. 

•  Serve as a one-stop source of information, care and service for cancer survivors, 

family members and service providers. 

 

Centers Include: 

Abramson Cancer Center, University of Pennsylvania, Philadelphia, PA, 215-615-3371 

Dana-Farber Cancer Institute, Boston, MA, 617-632-5100 

Fred Hutchinson Cancer Research Center, Seattle, WA, 206-667-2814 

Memorial Sloan-Kettering Cancer Center, New York, NY, 212-639-2581 

Ohio State University Comprehensive Cancer Center – James Cancer Hospital and 

Solove Research Institute, Columbus, Ohio, 614-293-6401 

UCLA’s Jonsson Comprehensive Cancer Center, Los Angeles, CA, 310-206-1404 

University of Colorado Cancer Center, Denver, CO, 303-239-3397 

University of North Carolina Lineberger Comprehensive Cancer Center, Chapel Hill, NC, 

919-966-7230 

http://www.iom.edu/�
http://www.youtube.com/watch?v=YhuqWM3dNAw�
http://www.healtoday.com/�


 

 

© NearSpace, Inc. 2008  28 of 34 

National Center for Complementary and Alternative Medicine (NCCAM) 

NCCAM is the federal government’s lead agency for scientific research on complementary and 

alternative medicine (CAM). The mission of NCCAM is to: 

 

1. Explore healing practices in the context of science. 

2. Train medical researchers. 

3. Spread information to the public and professionals. 

 

Call 1-888-644-6226, send an e-mail to info@nccam.nih.gov or visit the website at 

http://nccam.nih.gov 

 

National Coalition for Cancer Survivorship (NCCS) 

NCCS is the oldest survivor-led cancer advocacy organization in the country. Members 

advocate for quality cancer care for all Americans and empowering cancer survivors. 

Patient education also is a priority for NCCS, which offers the Cancer Survival Toolbox®. This 

award-winning audio set is provided to Survivors, caregivers and clinicians at no cost. NCCS 

believes access to credible and accurate patient data is vital to asking for and getting quality 

cancer care. 

 

Call 1-888-650-9127 or visit the website at http://www.canceradvocacy.org. 

 

Northern California Cancer Center (NCCC) 

The NCCC is a nonprofit group that works with researchers, patients, educators, community 

based groups and academic centers. The NCCC is committed to preventing cancer and 

improving the quality of life for those living with cancer. 

 

The NCCC studies: 

 

• The causes of cancer 

• Cancer survivorship 

• Cancer screening 

 

The NCCC manages: 

 

• A statewide breast and cervical cancer referral service for low-income women. 

• A statewide NCI-Cancer Information Service Partnership Program that focuses on 

improving outcomes that have to do with cancer. (This is done mainly in places where 

people may not be getting the medical care they need). 

• A community education program for patients and families, the general public and 

health care providers. 

 

Call 1-510-608-5000 or visit the website at http://www.nccc.org. 

 

http://nccam.nih.gov/�
http://www.canceradvocacy.org/�
http://www.nccc.org/�
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The Wellness Community 

This is a global nonprofit group that gives support, education and hope to people with cancer 

and their loved ones. They can learn vital skills that let them regain control, reduce isolation, 

and restore hope by taking part in professional-led support groups, workshops, nutrition and 

exercise programs, as well as stress reduction classes. All programs are free. 

 

Call 1-888-793-WELL send an e-mail to help@thewellnesscommunity.org or visit the website 

at http://www.thewellnesscommunity.org. 

 

As of this October 2008, all resource URLs are current. In the event of any changes, you can 

find the most recent information at JourneyForward.org. 
 
 

http://www.thewellnesscommunity.org/�
http://www.journeyforward.org/�
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